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SOFTWARE LICENSE AGREEMENT

ACI grants you a non-transferable, non-exclusive license to use this
copy of the program and accompanying materials according to the
following terms:

LICENSE:

You may:

a) use the program on only one computer at a time;

b) make one (1) copy of the program in machine readable form solely
for backup purposes, provided that you reproduce all proprietary
notices on the copy;

c) physically transfer the program from one computer to another,
provided that the program is used on only one computer at a time; and
d) transfer the program onto a hard disk only for use as described
above provided that you can immediately prove ownership of the
original diskettes.

You may not:

a) use the program in a network unless you pay for a separate license
for each terminal or workstation from which the program will be
accessed;

b) modify, translate, reverse engineer, decompile, disassemble, cre-
ate derivative works based on, or copy (except for the backup copy) the
program or accompanying materials;

c) rent, transfer or grant any rights in the program in any form or
accompanying materials to any person without the prior written consent
of ACI which, if given, is subject to the conferee’s consent to the terms
and conditions of this license; or

d) remove any proprietary notices, labels or marks on the program and
accompanying materials.

This license is not a sale. Title and copyrights to the program, accom-
panying materials and any copy made by you remain with ACI.
TERMINATION

Unauthorized copying of the program (alone or merged with other
software) or the accompanying materials, or failure to comply with the
above restrictions will resultin automatic termination of this license and
will make available to ACI other legal remedies. Upon termination you
will destroy or return to ACI the program, accompanying materials and
any copies.

LIMITED WARRANTY AND DISCLAIMER

THE PROGRAM AND ACCOMPANYING MATERIALS ARE PRO-
VIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS
FOR A PARTICULAR PURPOSE.

ACI does not warrant that the functions contained in the program will
meet your requirements or that the operation will be uninterrupted or
error free. The entire risk as to the use, quality, and performance of the
program is with you. Should the program prove defective, you, and not
ACI, assume the entire cost of any necessary repair.

However, ACl warrants the diskettes on which the program is furnished
to be free from defects in materials and workmanship under normal use
for a period of ninety (90) days from the date of delivery to you as
evidenced by a copy of your receipt. The duration of any implied
warranties on the diskettes is limited to the period stated above. ACI's
entire liability and your exclusive remedy as to the diskettes (which is
subject to you returning the diskettes to ACI or an authorized dealer
with a copy of your receipt) will be the replacement of the diskettes or,
if ACI or the dealer is unable to deliver a replacement diskette, the
refund of the purchase price and termination of this Agreement.
SOME STATES DO NOT ALLOW LIMITATIONS ON HOW LONG AN
IMPLIED WARRANTY LASTS SO THE ABOVE LIMITATION MAY
NOT APPLY TO YOU. THIS WARRANTY GIVES YOU SPECIFIC
LEGAL RIGHTS. YOU MAY ALSO HAVE OTHER RIGHTS WHICH
VARY FROM STATE TO STATE.

LIMITATION OF LIABILITY

IN NO EVENT WILL ACI BE LIABLE FOR ANY DAMAGES, INCLUD-
ING LOSS OF DATA, LOST PROFITS, COST OF COVER OROTHER
SPECIAL, INCIDENTAL, CONSEQUENTIAL OR INDIRECT DAM-
AGES ARISING FROM THE USE OF THE PROGRAM OR ACCOM-
PANYING MATERIALS, HOWEVER CAUSED AND ON ANY THE-
ORY OF LIABILITY. THIS LIMITATION WILL APPLY EVEN IF ACI OR
AUTHORIZED DEALER HAS BEEN ADVISED OF THE POSSIBILITY
OF SUCH DAMAGE. YOU ACKNOWLEDGE THAT THE LICENSE
FEE REFLECTS THIS ALLOCATION OF RISK. SOME STATES DO
NOT ALLOW LIMITATION OR EXCLUSION OF LIABILITY FOR
INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE
LIMITATION MAY NOT APPLY TO YOU.

GENERAL

This Agreement will be governed by the laws of France. In any dispute
arising out of this Agreement, ACI and you each consent to the
jurisdiction of the courts of France.

Use, duplication or disclosure by the U.S. Government is subject to
restrictions stated in paragraph (c) (1) (ii) of the Rights in Technical Data
and Computer Software clause at 252.227-7013.

Licensor: ACIl, 5 Rue Beaujon, 75008 Paris, France

This Agreement is the entire agreement between us and supersedes
any other communications with respect to the program and accompa-
nying materials.

If any provision of this Agreement is held to be unenforceable, the
remainder of this agreement shall continue in full force and effect.

If you have any questions, please contact: ACI Customer
Service, (33) 1 42 27 37 25 or write us at the above address.
SIGN AND MAIL THE REGISTRATION CARD TODAY.
Return of the registration card is required to receive any
product updates and notices of new versions or enhance-
ments.

All trade names referenced are the trademark or registered trademark
of their respective holder.

4th DIMENSION, 4D Runtime, 4D, and the abstract 4 logo are trade-
marks of ACIUS, Inc. and ACI.
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QUICK START

WELCOME TO 4th DIMENSION

This Quick Start booklet introduces you to 4th DIMENSION.
The six chapters are tutorials—step-by-step explanations—
that show you how to use 4th DIMENSION to create useful
databases. As you work through the tutorials, you will get a
feel for the major parts of the application and how to move
between them.

It should take you no more than an hour and a half to work
through all the chapters. When you have finished Quick Start,
you can start building your own 4th DIMENSION databases, or
you can move immediately to the more advanced tutorials in
the 4th DIMENSION Tutorials.

vil
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About the Quick Start Tutorials |

These tutorials teach you how to create a 4th DIMENSION
database, and enter and modify records. Then you will learn to
use some of the special features of 4th DIMENSION—graphs,
quick reports, and labels—to produce printed output.

You should work through the tutorials in order. The work you
do in each chapter prepares the database for the work you will
do in the next chapter. Each chapter begins with an estimate of
how long it will take you to complete the work in that chapter.
You can feel free to stop at the end of any chapter, take a
break, and begin the next chapter by opening the database you
have been working on.

Every step is explained in careful detail. The tutorials are
designed to be practical. so that you can learn

4th DIMENSION concepts while you are actually using the
program. You will create a database that keeps personnel
records for the employees of a (fictional) company.

The tutorials provide specific steps for you to follow as well
as general information that explains 4th DIMENSION.

The steps are usually followed by a short comment or
explanation. The format for steps and explanations looks like
this:

The numbered step tells you exactly what to do. The
characters you type at your computer keyboard appear in
bold type like this.

Following the numbered step is a separate paragraph that
offers a pertinent explanation or comment.

Another formatting element you will see is this note:

ﬁ Comment: This format is used for comments about the
operation of some of 4th DIMENSION’s features. Such
comments may provide a caution, point out a useful additional
feature, or provide other information.

The tutorials in this book assume that you are familiar with
basic Macintosh operations such as selecting objects, choosing
menu items, clicking, dragging, and so on. A few of the most
important operations are reviewed at the end of this preface.
For complete information and instructions, see the user guide
that came with your Macintosh.
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Introducing Databases

This section introduces a few concepts you will become
very familiar with as you learn to use 4th DIMENSION.

People use databases constantly in their homes and
businesses. Recipe collections, dictionaries, parts lists,
indexes, checkbooks, and other sources of organized
information—all are databases. A telephone book is another
example of a familiar database. Its alphabetical organization
allows you to find the information you need quickly.

Figure P-1
Databases of many kinds

ix
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Databases like those you can create with 4th DIMENSION
provide many advantages over paper-and-ink databases.

You can enter and modify information quickly. You can
analyze the information in different ways. You can reorganize
it, look at a portion of it (just a few records), or perform
calculations with it.

The information in the telephone book or in your address
card file consists of names, addresses, and phone numbers.
Each piece of information, such as a name, is placed in a
location called a field. All the information for one person
makes up one record. And all the records are stored in a file.

Fields
First Name Last Name Start Date [Salary [Title
{TonT Johnson 1/5/87 21000 |Engineer
Alice Bentley 3/6/87 21000 |Engineer
Biff Davis 1/2/80 43780 |Salesperson
Shirley R 1711780 36040 |Supervisor
Lance Wolfram 1714/80 27300 [Technician
Dennis Hanson 1714780 40520 |Manager
Hecords Lydia Yernon 1715780 36870 [Supervisor
Andy Venable 1/15/80 43520 |Engineer
Bryan Pfaff 1/22/80 26440 [Secretary
Jim Borrell 1/22/80 36540 Salesperson
MNancy Heizer 1/23/80 26270 (Clerk
Kathy Forbes 1/28/80 18840 |Secretary
Garth Hammons 2/6/80 50100 [Salesperson
Mary Smith 2/7/80 S5000 (Engi
Figure P-2

Fields and records make up a file
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A record and its fields can be visually represented in several
ways. The telephone book shows each record as one line

in a list; the card file shows each record as a separate card.
Figure P-3 shows how fields and records can be displayed
in two ways.

Employees

Last Name Borrell

First Name |[Jim

Start Date 1/22/80
Salary 36540
Title Salesperson

|

I

' First Name Last Name Start Date [Salary Title
Tom Johnson 1/5/87 31000 [Engineer
Alice Bentley 3/6/87 31000 [Engineer
Biff Davis 1/2/80 43780 [Salesperson
Shirley Ransome 1/11/80 36040 [Supervisor
Lance Wolfram 1/14/80 27300 |Technician

| Dennis Hanson 1714780 40520 |Manager
Lydia Vernon 1/15/80 26870 |Supervisor
Andy Venable 1/15/80 43520 [Engineer
Bryan Pfaff 1/22/80 26440 |Secretary

S 1BEPFEN 722780 ETHOISTIESpRr SO
Nancy Heizer 1723780 o2 U|LTerk
Kathy Forbes 1/28/80 18840 |Secretary
Garth Hammons 2/6/80 50100 Salesperson
Mary Smith 2/7/80 55000 |Engineer

Figure P-3

Two ways of representing one record

The field label identifies the kind of information the field
contains. As you can see in Figure P-3, each record has the
same fields no matter how it is displayed.

In 4th DIMENSION, you can vary the arrangement of fields on
different /ayouts. Figure P-4 shows three layouts that contain
fields from the same database.

PREFACE: WELCOME TO 4TH DIMENSION ~ Xi
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Anderson, Willy
(415) 555-1232

1542 South Henderson

Oakland cA 94703

Last Name First Name Phone Number
Anderson Willy (415) 555-1232
Osborne Andrew (212) 345-8885
Frashnar Pandgib (212) 555-1298
Johnson Samuel (714) 523-1284
Richardson Emily (332) 765-2143
Northgate Oliver (605) 667-2310

Anderson, Willy (415) 555-1232

1542 South Henderson Oakland CA 94709

Osborne, Andrew (212) 345-8885

7862 San Pablo Bivd Sarander NS 10907

Frashnar, Pandgib (212) 555-1298

€783 4204 5t Kew York Ny 18976

Johnson, Semuel (714) 523-1284

62 Mardenbrook Ln Marshat Fa 20786

Richardson, Emily (332) 765-2143

534 Harding Ave. Bismark N 60874

Northgate, Oliver (605) 667-2310

8873 Falutin Hwy Scranton PA 20887

Figure P-4

Several layouts for the same database

The telephone book and card file are examples of simple
database files, in which all the records store the same kind of
information. More complex databases are made up of several
files. Each file contains a different kind of information.

The information in one file can be related to information in
another. At the telephone company, for example, one file
stores names, addresses, and telephone numbers, and another
file keeps track of the telephone calls that are made from
each telephone number. At the end of the month, invoices
are created from the records in both files to produce telephone
bills.

The concepts introduced in this section are basic to any
database, including the large-capacity databases that keep
track of credit card transactions, telephone billings, invoices,
financial accounts for large corporations, publicly traded
stocks and bonds, sales information, inventory lists, and data
for scientific projects.

You will learn more about these ideas as you work with the
tutorials in your 4th DIMENSION package.
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Basic Operations for Macintosh Computer

The tutorials in this book assume that you know how to use

a Macintosh computer. Here is a quick review of some basic
terms. For complete information and instructions, see the user
guide that came with vour computer.

Desktop: The Macintosh screen represents a desktop, on

which vou ¢

an arrange the various items vou want to use

Icons: Disks. documents. folders. and applications are
represented on the desktop by icons, pictorial representations
of the items. Icons also represent actions and tools.

You click an icon to activate the function.

Mouse: To perform some functions on the Macintosh you
move the mouse and press the mouse button. The pointer on
the screen follows every move you make with the mouse on
your work surface.

Pointer: The mouse pointer is usually shaped like an arrow,
but it can change shape to give you certain kinds of
information. It can be an I-beam when you are ready to edit
text, or a wristwatch when the Macintosh is performing an
operation you must wait for.

Clicking: You click on-screen elements such as icons,

check boxes, and buttons to select or activate them. You click
by positioning the pointer on the item and then pressing and
releasing the mouse button.

Selecting: You select something on the screen—an icon,

a file, a piece of information—by clicking it. When something
is selected, it is highlighted (that is, inverted—black becomes
white, white becomes black) to show that it is selected.

You always select whatever you want to work on next.

Double-clicking: Very often you can select an item and
immediately perform an operation by double-clicking.

This means rapidly clicking an item twice. Your Macintosh
performs the expected operation, based on the situation at the
time. For example, if you double-click the 4th DIMENSION
application icon, the Macintosh opens the application.
Double-clicking in this case is a shortcut for selecting the
icon and then choosing Open from the File menu.
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Dragging: You often can drag something on the screen to
change its location. To drag, you position the pointer on
the item you want to move, then press and hold the mouse
button while you move the mouse. When you release the
mouse button, the item remains in its new location.

Choosing menu commands: You choose a menu command
to tell the Macintosh what you want to do with a selected item.
To choose a menu command, you pull down the menu by
pressing and holding on the menu title. Then you drag the
pointer down the list of menu commands until you highlight
the one you want. When you release the mouse button, the
command is performed.

IR Edit

Figure P-5
Choosing a menu command

Dialog boxes: Your Macintosh displays a dialog box
whenever it needs information from you to carry out a task,
such as saving a document. The dialog box has action buttons
to click, such as OK, Cancel, or Save, and it sometimes has

a place for you to type information, such as the filename you
want to use for a document.

Before You Begin

Before you can start 4th DIMENSION, you must install it on
your hard disk. For complete directions, see the Read This
First booklet included with your package.

You must also install the sample databases from the

4th DIMENSION Tutorials disk to your hard disk.

You will use the sample databases as you work with the
tutorials. The instructions assume that the sample databases
are in the same folder as the 4th DIMENSION application.
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CREATING FILES AND FIELDS

Estimated time to complete: 15 minutes

This chapter takes you through the first basic steps in creating
a database.

When you create a new 4th DIMENSION database, the
program automatically creates a database file. The file image
appears on your screen. You will soon create fields for this
file. In 4th DIMENSION. the file and its fields are the basis
of the structure of vour database.

Because 4th DIMENSION automatically creates the first file
for you, your job is simply to rename the file and create fields
within the file. 4th DINMENSION then uses this file to store and
retrieve the records vou create.

When vou have finished this chapter vou will know how to
B Crcale a aatabase

B rcnam ¢ ainle

m create fields

m set field types and field attributes

CHAPTER 1: CREATING FILES AND FIELDS 3
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4th DIMENSION® 2.0

Creating a 4th DIMENSION Database

In this section, you will create the database you will be using
with all the tutorials in this booklet.

Open 4th DIMENSION.

You can either select the 4th DIMENSION program icon and
then choose Open from the File menu, or you can double-click
the icon.

For complete information about installing and starting
4th DIMENSION, see Read This First.

4th DIMENSION displays the Welcome screen.

Mick Renner

[£3 4th DIMENSION]

[ Personnel 10
O Personnel 3

O Personnel 4

O Personnel 5

O Personnel6 @y O
O Personnel 7

O Personnel 8

O Personnel 9

O Personnel MPL

Figure 1-1
4th DIMENSION Welcome screen

The names of the 4th DIMENSION sample databases you
copied to your hard disk appear in the file area, as shown in
Figure 1-1. If there are no 4th DIMENSION databases in the
folder, the file area is blank and the Open button is gray.

To create a new database, click New.

4th DIMENSION displays a dialog box for you to enter the
name of the new database.
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Type Personnel.

This is the name 4th DIMENSION will use to save your
database. |
ﬁ Note: Database names can be any valid Macintosh filename.
The Macintosh allows you to use any characters on the

keyboard except the colon (:). Also, don't start a filename with a
period (.). You can use up to 25 characters.

Click Save.
4th DIMENSION displays the Structure window, which
contains a single empty file, named [Filel].

= Note: Throughout this book and other 4th DIMENSION
documents, filenames are shown in brackets. This helps
distinguish filenames from field names, layout names, and other
names you use for items in the application.

When you create a new database, as you have done here,

4th DIMENSION starts in the Design environment. This is one
of three 4th DIMENSION environments that you will become
familiar with.

The Design environment is where you create the structure of
a database.

CHAPTER 1: CREATING FILES AND FIELDS 5



Renaming a File

When you start 4th DIMENSION, you see the first file image in
the Structure window. This window shows the file structure of
the database (the files and their relationships). Since this is a
new database, there is only one file.

& File Edit Use Design Structure

Structure for Personnel

Filename bar

File image
New File... EN
New Field...  ¥F

L haage Field...

Figure 1-2

The Structure window

For this tutorial, assume that you have analyzed the
information needs of the personnel department for your
company. In this first file you will keep employee information.

The first 4th DIMENSION file is automatically named [Filel].
Since the filename is highlighted, you can tell that it is already
selected. (If the filename is not highlighted, click it to select
it.) You will change the filename to one that is more
descriptive. Since you are going to keep track of your
employees in this file, you decide to name it Employees.

ﬁ Note: 4th DIMENSION often provides preset, or default, names
for things, such as [File1] and Field1. You will usually want to
change these names to something more meaningful to you.

Choose Rename File from the Structure menu.

4th DIMENSION displays the File Attributes dialog box for
you to enter the new filename.



Access system
boxes

QUICK START

File Attributes...
Filename: [[FIEX] |

- Record Access

Load: IHII Groups

save: |[All Groups

Add:  |[AN Groups

Delete: |[All Groups

Cancel | 0K

U

Figure 1-3
The File Attributes d‘c\ log box

1l ' Note: The boxes below the Filename box allow you to set
Pri\

password access privileges to this file. You can control who
has access to the file and for what purpose. You will find an
ntroduction to s ng the 4th DIMENSION Password Access
~System in the 4th DIMENSION Tutorials.

The filename box is already selected, ready for you to enter
the new filename.

Type Employees and then click OK.

The Structure window displays the renamed file. You are now
ready to create the fields for this file.

CHAPTER 1: CREATING FILES AND FIELDS 7



Creating Fields

You want to keep track of each employee’s last name, first
name, start date, salary, and title. Each of these pieces of
information is stored in a separate field. Your next task is to
create these fields.

4th DIMENSION highlights the filename to show that it is the

current file.
1. Choose New Field from the Structure menu.
New File... #EN
Rename File... %R 4th DIMENSION displays the Field dialog box. The Name

New Field...  ®F box is highlighted, ready for you to replace Field1 with an
{ haage Field... appropriate ﬁeld name.

2. Type Last Name.

Be sure to type the words Last Name, not your own name.
You are naming the field that will later store the last names of
the employees.

Field for file Employees
Name: lLast Name
~Types — _ Attributes
® 20 [JMandatory
O+ [ pisplay only
o [JCan't modify
[ Indexed
O Integer [ sndggue
O Long Integer| | (] Choices
O Date
O Time
Q Boolean '[ 0K & Nexnt ]I
O Picture
O D subfile ((cancel [ ok )
| —

Figure 1-4

The Field dialog box

As you can see from Figure 1-4, each field can be one of ten
field types and can have one or more field attributes. The field
type determines the kind of information you can enter into the
field. The attributes determine how each field will be handled
during data entry and display.
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For this tutorial you will use three of the field types:

Alpha: For letters, numbers, and special characters—often
called alphanumeric information. You can specify the
maximum number-of characters in an Alpha field, from

2 to 80 characters.

Real: For numbers that include decimals (real is short for
real number).

Date: For dates.
And you will use one field attribute:

Indexed: When a field is /ndexed 4th DIMENSION creates
a special internal file that allows you to search and sort
records very quickly. Each index takes some disk space,
so you won’t index every field. just the ones that you are
likely to use often for searching and sorting.

For more information about field types and attributes, see
the 4th DIMENSION Design Reference.

The field type for the Last Name field, Alpha, is already
selected. However. vou should change the 20 to 15. The 15
means that you can enter up to 15 characters into this field.

® ::Ac: fAipha 15 | 3. Select the box next to Alpha, either by pressing the Tab key
or by clicking.

Type 15 in the box to the right of Alpha.
& Indexed 5. Select the Indexed field attribute.

You will often use Last Name to locate specific records and
to sort them. The Indexed attribute makes these tasks quick.

6. Click OK & Next.
4th DIMENSION displays another Field dialog box for the
second field.

7. Type First Name, make the field type Alpha 15, and select
the Indexed field attribute.

You will often use First Name together with Last Name to
search and sort records.

CHAPTER 1: CREATING FILES AND FIELDS 9
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® 141} Date

Filename

10.
11.

12.
13.
14.

Click OK & Next, or just press Return (the shortcut for
OK & Next).

4th DIMENSION displays a third Field dialog box.

As you can see, you create fields by typing the field name

in the Name box and choosing the type and attributes. OK &
Next accepts the field name, type, and attributes and displays
the next Field dialog box. From now on, these step-by-step
instructions assume that you know how to create a field.

Create a field named Start Date, and make the field type Date.

The Date field type allows you to enter dates into this field
and to perform calculations based on dates. For example,
you can calculate how long an employee has been with the
company by calculating the difference between the start date
and today’s date.

Click OK & Next or press Return.
Create a field named Salary, and make the field type Real.

The Real field type allows you to enter numbers with decimal
points (such as dollars and cents) into the field and to perform
calculations on the values you enter. For example, if you ente:
annual salary figures in the Salary field, you can calculate the
monthly salaries based on the annual figure.

Click OK & Next or press Return.
Create a field named Title, and make the field type Alpha 12.

This time, click OK (not OK & Next) to return to the Structure
window.

If you accidentally click OK & Next, click Cancel to avoid
creating an unnecessary field.

Field type symbols

- Employess
Last Mame
First Name
Start Date
Salary

Title

Figure 1-5
The Employees file with the field names
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You have now created the fields you need for this file.
The field names are displayed in the file image. The field
type symbol (A for Alpha. R for Real, and D for Date) is
displayed next to each field name. The indexed fields
(Last Name and First Name) are displayed in bold type.

You can change any field at anv time. You can edit the field
name, change the attributes. and even change the field type.
You can add a field whenever vou need to; each file can have
up to 511 fields.

The Next Step

Now that your file has fields. vou are ready to create layouts.
In the next chapter you will create an input layout to use when
you enter the records, and an output lavout to list the records
on the screen of your Macintosh

If you want to stop working with <th DIMENSION for a while,
you can do so now. You do not need to m ake any special
effort to save your work. \\ vou are creating a database,
4th DIMENSION automatically saves vour w ork. When you
enter information into the recc \7;\. the information is saved

automatically at regular intervzls.

You can quit 4th DIMENSION z: ;ti; time by choosing

Quit from the File menu. All the work vou have done is
saved automatically. You can open m_\ database again

by starting 4th DIMENSION and choosing the database

from the Welcome screen.

CHAPTER 1: CREATING FILES AND FIELDS
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CREATING LAYOUTS
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Single-record
format shows
one record at
atime

CREATING LAYOUTS

QUICK START

Multi-line format
shows many
records in a list

Estimated time to complete: 10 minutes

Layouts are the forms you use when you enter, view, and print
information. Essentially, the layouts determine how you see
the fields when you are creating records and printing reports.

Employees

Last Name  |Johnson

First Nsme |Tom

Start Date

Salary 28500

Title Engineer
First Name Last Name Start Date Salary Title
Mike Krause 3/18/80 33340 | Designer
John Johnson 3/19/80 18250 [Clerk
Calvin Margolis 3/20/80 52000 |Salesperson
LAndy Tompkins 3/28/80 19770 | Technician
Laurence Nanneman 4/1/80 55900 |Salesperson
Michael Sleeter 4/10/80 25650 | Technician
Rick Reed 4/15/80 18150 |Clerk
Mike Ross 4/17/80 58910 |Director
Daniel Maloy 4/24/80 42910 [Manager
Chris Nash 4/28/80 34980 |Designer
Figure 2-1

4th DIMENSION layouts

You can have as many layouts as you want for each file.
You can use one layout for entering information and a
different layout to display it. On any layout you can

m use all of the fields, some of the fields, or no fields at all

m use different type styles, backgrounds, and other graphic
elements that you draw or paste in from the Clipboard

m add descriptive text, such as directions for the person who
will be entering the information

m create an effective color scheme for your layouts on a color
monitor

m add custom buttons

You can find complete information about how to add
these features to a layout in the 4th DIMENSION Tutorials
and the 4th DIMENSION Design Reference.

In this chapter you will create one layout for entering
information, called an input layout. Then you will create
a layout for listing information, an output layout.

CHAPTER 2: CREATING LAYOUTS
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Creating an Input Layout

You have created the file and the fields; now you will create
a layout to use for entering records.

Design Choose Layout from the Design menu.
ETTE e 4th DIMENSION displays the Layout dialog box.
Procedure... %P 3 i
Menu... %M You use this dialog box to open any layout you create.
Passwords
Lsts Layout... l&
Fil :
ilename T —
panel
Layout display
panel [_boen |
a | Done
O tnput Name: || |
O Butput fccess: [ ]
Figure 2-2
The Layout dialog box
The Layout name panel is on the left. After you create a
layout, the layout name will be displayed beneath the
filename.
The Employee filename is highlighted. (If it is not highlighted,
select it.) Now you are ready to create a layout for this file.
Click New.

4th DIMENSION displays the New Layout dialog box.



QUICK START

Output layout

New layout for Employees (O 9 point

Font size: .
tempiates Select fields: . 12 puint
Lazt Mame o)
Field names Start Date S R B
i | =
Input layout
templates E CusToM

Layout Name:

= T

X Enterable linked fields

[ Eupand } [ Select ] [ Cancel J [ 0K J

Figure 2-3

The New Layout dialog box

The New Layout dialog box is where you name the layout
and choose the fields vou want to include, the font size, and
the standard layvout template you want to use. A layout
template is a pattern 4th DIMENSION uses to create a layout.

The layout templates have been designed to display
information effectively. 4th DIMENSION provides three
templates for listing information in a row-and-column format
and five templates that display one record at a time. You will
usually start with one of these templates for your layout, and
then modify the lavout itself to suit your needs exactly. If you
wanted to design an original layout yourself, you would
choose Custom from the group of templates.

4th DIMENSION automatically places all the fields in the
layout, unless vou select specific fields you want to use.
Since you will use all the fields for your employee input
layout, you do not need to select any. You will use the layout
template that is already selected.

3. Type Employee Input to name the input layout you are
creating.

The Layout Name box is already selected when the dialog box
opens, so you can type the layout name immediately.

CHAPTER 2: CREATING LAYOUTS 17



Fields placed
next to field
labels

Click OK.

4th DIMENSION creates the layout and displays it in the
Layout editor. The Layout editor allows you to modify any
layout, either immediately after you create it (as you have just
done) or later if you discover a need to change the layout.
Your layout includes all the fields displayed in the order they
were created.

Click the zoom box so that the Layout window fills the
entire screen.

The zoom box is in the upper right corner of the window.

Expanding the Layout window lets you see the layout as it
will appear during data entry.

% File Edit Use Design Layout Object Font Style

e,
L]

Layout: Employee Input E=="—————V115
N "
OlAl Employees
[ -
[so
0| Last Name | [Last Name ] :
== '
— First Name | [First Name ] L
il F100
== Start Date Start Date r
= (| | Salary .
= [150
IaL[|||.|.| i Title [Title r
I i
rzoo
& :3 DB
EAER .
[250
S0 14 150 200 250 300 350 40] 1/1

Figure 2-4

Your first layout

You will use this layout to enter the information in the fields.
The field labels identify each field. The field names that appear ‘
within the fields on this layout will not appear on the layout
when you use it for data entry.

This type of layout is a common one for data entry. Records
appear on the screen one at a time. When you have entered
the information in the fields for one record, you go on to the
next record.



QUICK START

Your input layout is ideally suited to enter information.
In the next section you will create a standard output layout
that displays several records at a time in a list format.

Creating an Output Layout

CusTon

To view as much information at one time as possible,
you need a display that lists records in rows and columns.
A list layout lets you display and print many records.

To create a second layout. vou use the Layout dialog box and
the New Layout dialog box again. Because you are familiar
with the steps for creating a layout, the following instructions
are somewhat shorter than the earlier instructions.

Choose Layout from the Design menu.

4th DIMENSION displays the Layout dialog box.
The [Employees] filename is highlighted.

Click New in the Layout dialog box.
4th DIMENSION displays the New Layout dialog box.

Enter Employee List as the lavout name in the New Layout
dialog box.

Select the first layout template (in the upper left corner of the
template choices), and make the font size 9-point.

The first three standard lavout templates are for output layouts.
They display the records in rows and columns. The first
template, the one you have chosen, shows the field names at
the top of the columns.

For your output layout. you want the employees’ first names
to appear in the first column. so you need to select the fields
manually to place them in a different order on the layout.

Select First Name in the fields list, then click the Select button.

4th DIMENSION places a number 1 next to First Name.
The number indicates the selection order for the field.

CHAPTER 2: CREATING LAYOUTS
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New layout for Employees — @ 9 point
Select fields: O 12 point
Last Name Q

Start Date

Salary

Title

=
E CusToM

Layout Name:
7] IEmpIogee Lis{ |

X Enterable linked fields

[(upens | [ setect | ( cancet ] [ ok ]

Figure 2-5
The New Layout dialog box for your second layout

Select Last Name, then click the Select button.

4th DIMENSION places a number 2 next to Last Name.
4th DIMENSION provides a shortcut for selecting fields:
Double-click Start Date.

Double-clicking a field selects it for the layout.

Select Salary and Title in the same way.

You can use either the Select button, or double-click the field
names.

New layout for Employees @® 9 point

Font size: O 12 point

Select fields:

Last Name
First Name
Start Date

Salari

&

amas o=

BN —-N

Layout Name:
gy |Emp|ogee List |

X Enterable related fields

(Ceancel ) (k)

Figure 2-6
Title field selected




QUICK START

9. Click OK.
+th DIMENSION creates the output layout for you.

10. Drag the size box to expand the window so that you can see
how the layout is designed.

Using the size box to expand the window is an alternative to
using the zoom box.

& File Edit Use Design Layout Object Font Style

Field labels Sm—————— Layout: Employee List ==ie0F————=
First Name | Last Name | lStar( Date I lSalarg | Title 1t
. ® J[A] First Name ‘J Last Name '_II Start Date l_“Salan.{__!_]|T1'Qle 5::
Fields —l 1 ] ] ] 1
=T L
Ea
=|EH
Figure 2-7

Your output layout

This layout also shows all the fields for a single record.

The fields are placed below the field labels. When this layout
is used, it will automatically generate a row-and-column
listing of records with a field label at the top of each column.

11. Close the layout windows by clicking their close boxes in
—— the upper left corners of the windows.

4th DIMENSION returns to the Structure window.

4th DIMENSION automatically saves the layouts you have
created when you close their windows.

4th DIMENSION lets you create many different layouts. When
you are entering and managing information, you will always
use one input layout and one output layout.

4th DIMENSION uses the input layout when you enter or
modify information. It uses the output layout to display the
records as a list.

CHAPTER 2: CREATING LAYOUTS
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The Next Step

You have completed the basic steps necessary to start using
4th DIMENSION to enter and manage employee records.

You have created the database structure: the file with its fields.
And you have created layouts that you can use to enter and
display data. Now you are ready to begin entering information
and using it for practical purposes.

If you want to take a break, feel free to do so.

4th DIMENSION automatically saves everything you have
worked on when you quit. You can open the Personnel
database you have created when you start again.
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ENTERING, IMPORTING, AND
MODIFYING DATA
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QUICK START .

ENTERING, IMPORTING, AND
MODIFYING RECORDS

Estimated time to complete: 15 minutes

You have used the Design environment to create the database
structure and layouts. You will now work in the User
environment to enter information in the fields. In addition,
vou will import data from another application.

The User environment allows you to manage data.

You can search for records, you can sort the records, you
can print reports and labels, and you can even graph the
information. The User environment gives you all the
capabilities you need to work with your data productively.

In this chapter you will learn how to
® enter records
® import records from another application

® view records

modify records

NTEM A FAITEMIA LA A AP -
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vDesign XY

User #U

Runlime i

Enter
New Record EN
Moiify Beoard o

Entering Records

Rpply Formula..,

Enter in List %,

Control panel
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You are going to enter a few records into the database you
have just created. You created your database structure in the
Design environment. To enter records, you simply change to
the User environment.

If you are returning from a break, start 4th DIMENSION and
open the Personnel database you created in the first chapters.

Choose User from the Use menu.

4th DIMENSION displays the message “There are no records
for: Employees.” If there were records, they would be
displayed on the screen using the output layout you created.

Choose New Record from the Enter menu.

4th DIMENSION displays your input layout. Here in the User
environment, you can select the fields to enter or modify your
data. Unlike the Design environment, you cannot select or
modify the other layout elements (the field labels, border, and
so on), only the contents of the fields themselves.

| & File Edit Use Enter Select Report Special

EE Entry for Employees EEI
K>
| Enter -
_Eiitar | Employees
Last Name |
First Name |
Start Date [00/00/00
Salary 0
Tite |
&
k3] I
Figure 3-1

The data entry screen ready to accept information

As you can see, the control panel on the left side of this screen
has several buttons. The control panel lets you enter or delete
records and move from record to record.
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The blinking insertion point is already in the Last Name field,
ready for your first field entry.

3. Type Johnson and press Tab.

You use the Tab key to move from field to field. To move in
reverse order, you use Shift-Tab. You can also use the mouse
to point to and select any field.

4. Type Tom and press Tab.

7 J;_ﬁ K f/i’
From now on, this kind of instruction will be given s1mply P
as “Enter Tom.” Eqs20hin T
"t &l &Y ' B
5. In the Start Date field. enter 1/5/87. S/1/47
]

You can also use hyphens. commas. periods, or spaces
instead of slashes to separate the numerals in the date
dd. mm. gy (mm-detyy, for example). Y?; always use numerals to enter

’.( P J the date. The mm/dd++ format is called the date entry format.
T
/bac s ?1”7 ¢ :(0 You can later change the way the date is displayed so that the
Bmericcan MWL‘(&& month is spelled out in f"'; or abbreviated (5 Jan 1979 or

u abb
January 5. 1979, for example). You will change the date
display format in the —'77: DIMENSION Tutorials.

Fr1

4th DIMENSION accepts the entry and moves the insertion

noint o th=e next A2l
POILIIL 1O UIT IITAL 1IT1d,

6. For Tom Johnson's salary, enter 28500.

Do not enter dollar signs or commas. When entering a “real”
number you use numerals and a decimal point (and a minus
sign for negative numbers). 4th DIMENSION accepts the entry
and displays it just as you entered it.

You can change the display format for this field also, so that
dollar signs and commas are displayed. You will change the
number display format in the 4th DIMENSION Tutorials.

7. For the title, enter Engineer.

All the fields are complete.

CHAPTER 3: ENTERING, IMPORTING, AND MODIFYING DATA 27
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Click Enter
to save the
record

L & File Edit Use Enter Select Report Special
I=—— Entry forEmployees =————01-

S Employees

Last Name  |Johnson

First Name [Tom

Start Date  |1/5/87
Salary 28500
Title |Engineer

Figure 3-2
Your first record ready to be saved

Click Enter or press the Enter key.

4th DIMENSION accepts the record and displays a
blank record.

When 4th DIMENSION accepts a record, it stores it in

the database. You can display the record again to view

the information or change it if necessary. The blank layout
you now see on the screen is not yet a record; it will become
one when you accept the record by clicking Enter (or by
pressing the Enter key).

Enter the information for the second record.

Last Name: Bentley

First Name: Alice ARl iy 7Y
Start Date: 3/6/87 _ /V‘-/:?//,v,v_) J o £)3)57

Salary: 29500

Title: Engineer




QUICK START

10. This time, after you click Enter, click Cancel when the
blank record appears.

4th DIMENSION displays both of the records you have
entered. As you can see, your output layout displays the
same data you entered, but it uses a multi-line format to
display the records in a list.

[ & File Edit Use Enter Select Report Special

I=——_'__‘—‘ Employees: 2 of 2

lFirst Name Last Name Start Date Salary Title
Tom Johnson 1/5/87 28500 |Engineer
Alice Bentley 3/6/87 29500 |Engineer
=
3

Figure 3-3

Records displayed as a list

CHAPTER 3: ENTERING, IMPORTING, AND MODIFYING DAT
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‘B(( es

-

Importing Records from Another Application

Ok (

You have entered two records into your database. To save
you the time of entering a series of records, we have prepared
a sample text file of practice records.

Suppose you have been keeping your personnel records in

a spreadsheet. You can export your data as text from the
spreadsheet, and import the text file into 4th DIMENSION.
Here is how the text file looks when displayed by a text editor:

[ & File Edit Search Format Font
[El=——— Personnel Tett =—r——————=

Biffe Davise - 1/2/80% 437809+ Salespersond
Shirleys Ransomes 1/11/80s 36040+ Salespersond
Lances Wolframe 1/14/80+ 27300+ Techniciand
Dennise  Hansons 1/14/80% 40520%  Managerd
Lydias Vernons 1/15/80% 36870+  Supervisorq
Andys Venables 1/15/80% 43520¢  Engineerd
Bryans Pfaff+1/22/30% 26440%  Secretaryq

Jims Botrrells  1/22/80% 36540+  Salespersond
Nancy» Heizers 1/23/80% 262709  Clerkq
Kathy+ Forbess 1/28/80% 188409  Secretary9q
Garths Hamonss 2/6/80% 50100+  Salespersond
Mary+ Smiths 2/7/80% 55000+  Engineerdq
Frederice Bells 2/14/80% 60400+ Directord
AlansHulls 2/20/80% 41460 Supervisord

Shirley+ Nalevankos2/21/80% 41050+  Designerdq
Jans Perezs 2/27/80% 22560+ Techniciand
Georges  Lyle+2/28/80% 47900+  Salespersond

Bills Guillardos 3/6/80+% 19610  Clerkq

Page § Normal

Figure 3-4

A text file of data

The text file contains one record for each employee. Within
each record, the fields are separated by tabs, and the end of
the record is indicated by a carriage return. You can import
such text files directly into 4th DIMENSION.




QUICK START

1. Choose Import Data from the File menu.
New Database...
Opan Botabese.. 4th DIMENSION displays the Import Data dialog box.
Import Data...
Export.Date.. | Import data... e My Hard Disk.
(tject ) tpen ]

Q[ grive ] [ Cancel )

®Text ODIF OSYLK
End of field: |9

End of record: |13

2| [Juse input layout

B

Append >»>

Hemops

First Name
Start Date
Salary
Title

Figure 3-5
The Import Data dialog box

The Import Data dialog box gives you a choice of file types
from which to import data. The Text file choice is already
selected. The ASCII code for Tab is entered in the “End of
field” box, and the ASCII code for carriage return is entered
in the “End of record” box. If your text file used different
characters to indicate the end of a field or the end of a record,
you would need to change these values. (For complete
information, see the 4th DIMENSION User Reference. ASCII
codes are used to represent keystrokes to a computer.)

You need to select the fields you want to import into

4th DIMENSION, using the order they appear in the text file.
The Import Data dialog box provides a list of fields so that
you can select the import order.

>
First Mame Append >>> —
Start Date
Salary Insert >>>
Title
Hamoaps |
4

Figure 3-6
Field list for importing data
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The text file you are using puts the First Name field before

the Last Name field, and your Personnel database places them
the other way around. The order of fields you specify in this
dialog box must reflect this difference (otherwise all employee
first names would appear in the Last Name field).

If the fields were in the same order in the text file as they
are in the database, you wouldn’t have to create a special
order of fields.

Select First Name in the list of fields on the left.
Click Append.

4th DIMENSION places First Name in the list of fields
on the right.

Select the second item, Last Name, in the list of fields on
the left, then click Append.

4th DIMENSION places Last Name in the list of fields on
the right. You can see how you use Append to create a list
of fields on the right that matches the order of fields in the
text file you are importing.

Use Append to add the remaining fields to the list on the right.

Last Name First Mame i
First Name Append >»> Last Name |

Start Date Start Date

Insert >»> Salary

Title

Salar

Hamaps

<

Figure 3-7
The final import order

If you make a mistake, you can use the Remove button to
delete any field from the list on the right. And you can use
the Insert button to place a field within the list of fields.

Be sure the order of fields on your screen matches the order
as shown in Figure 3-7.

This dialog box also lists the files in the 4th DIMENSION
folder. You have already copied the files on the Tutorials
disk into the 4th DIMENSION folder, so they are available
for this tutorial.



QUICK START

6. Select the Tutorial folder, and then click Open.
4th DIMENSION displays the tutorial files.
/ N [ 7 L[ .
7. Select Personnel Text. 72X74,/c Fersonur el [e€ L@
This is the text file created from a spreadsheet.
8. Click Open.
4th DIMENSION quickly imports the data from the
spreadsheet file. The records are added to the two records
you have already entered.
i e records, usi
Feel free to examine the records. using the scroll bar on the
right side of the window to move through the file.
) [ % File Edit Use Enter Select Report Special
Click to move I Employees: 54 of 56
up one record — =
lFlrsf Name Last Name Start Date Salary |Title
Click to move IMnke z T
Up one page John 3/19/8
Calvin 3/20/8 esperson
Drag the Andy TzeE chnician
elevator to Laurence - 0 J|Salesperson
move anywhere Michael - - f E '.ecr?ﬁ*,c\ar‘.
: Rick 215z Clerk
in the set of IMlke 4/17/8 0 [Director
records Daniel 4/24/8 42910 |Manager
Chris 4/287/8 34380 |Designer
Click to move cliff 4/23/2 28070 |Technician
down one page Jeff 4/20/8 50200 [Salespersen
Steve S/ 42990 |Supervisor
Don 16190 |Clerk
Keith 5712780 44790 [Salesperson
Click to move Martin 6/5/80 47200 |Salesperson
down one Barbars 6/11/80 43210 |Designer
reCOfd Jef E 6/23/80 29310 |Secretary
3 |
- —~ CL . 5N A 4 Fils, A~
€ = QEzal ) *\f_ e AL < Z zd
a— T =y
| " FI \/7'1;;2:;
/ / J/0C DO ¢ e ) d 6/¥c )
(‘ ) // 4 /& / a
Ll Iy: C ~ - (
/NG <(/ [ /O O P L0 VL | /‘/‘ '&L. =
.~ L ""”‘" " v .‘/‘ =
\’(‘ L} [ :— LS ¢ YN £J7 s { / "/ /3 /\//w-‘. /J/V’/.t“ o Mol
" I Y P4T
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Show All #06
S$haw Subset HH

Modifying Records

Search Editor... S
Search by Layout... L
Search and Modify...
Search by Formula...

Sort Selection... ®T
Sort File...

Enter

New Record #EN

Modify Record M

Apply Formula...

Enter in List %,
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The records in your database will often need modification.
People change their names; their job titles and salaries change.
People leave the company. In each case, the records need to
be modified.

Suppose that Tom Johnson’s and Alice Bentley’s salaries
have increased. You need to modify their records. The records
that you have imported are now the only records displayed.
Your first step is to display all the records.

Choose Show All from the Select menu.

This command shows all the records in the database.
Scroll to the top of the list.

Click anywhere in Tom Johnson’s record to select it.

You always select a record when you want to work on it.
You can select any record simply by clicking it.

[ & File Edit Use Enter Select Report Special

I=——— Employees: 56 of 56 §—§

29500 [Engineer
43720 |Salesperson
irley 5 1711780 36040 |Salesperson
Figure 3-9
Tom Johnson'’s record selected

Choose Modify Record from the Enter menu.

4th DIMENSION displays Tom Johnson’s record, ready for you
to modify the information.

Select the Salary field.

You can use the Tab key to move from field to field, or you
can click the Salary field with the mouse. If you click the field
with the mouse, the insertion point is placed where you click.
To select all the characters in the field, either drag across the
characters or double-click in the field.

Enter 31000.

Since you have another record to modify, click the left arrow
in the control panel to move to the next record.
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€ File

Edit

Use Enter Select Report Special |

Entry for Employees

Ol

N

"
o L)

Click here to move
to the nextrecord —

Click here to move
to the first record

" Enter

Delete

Cancel

Employees

| Johnson

[Tom

1/5/87
|31000

|Engineer

First Name

Start Date
Salary

Title

<l

10

(’ w

control panel to go to the next record

<th DIMENSION displays the next record. When you move
10 the next record, 4th DIMENSION accepts the changes

vou have made just as if you had clicked Enter. Notice that
vou can use the control panel to move from record to record

when vou are modifying records.

File Edit Use Enter Select Report Special

Click here to move
to the previous
record

= Entry for Employees =
Enter
Employees
) || Lest Neme
—_— ,—::_—] First Name |Alice
‘ Start Date  [3/6/87
- Salary 29500
:E Title |Engineer
_Cancel
&
<] [Dl&
Figure 3-11

Using the control panel to move from record to record

CHAPTER 3: EN
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New Record %N
Mopdify Record %M

Apply Formula...

Enter in List 3.,

Change Alice Bentley’s salary to 31000.

You may want to practice using the control panel to move
from record to record. You can see every record in the
database in this manner.

When you have finished, click Enter.
4th DIMENSION displays the records in the output layout.

Modifying Records in the List

You have entered and modified records using the input layout.
You can also enter and modify records directly in the output
layout. This is called modifying records in the list. Suppose
you need to change the title for Shirley Ransome, who has
received a promotion to Supervisor. Her record is the fourth
from the top.

Choose Enter in List from the Enter menu.
Click any field in Shirley Ransome’s record.

Clicking once places an insertion point in the field, ready
for you to modify the entry. Double-clicking selects a word
in the field. You can also drag over all or part of a field entry
to select the entire entry or part of the entry.

Press Tab until you have selected the Title field.
The records scroll to the left if necessary to bring hidden
fields into view.

Type Supervisor in place of the previous title.
Press Tab to move to the next record.

Moving to another record causes 4th DIMENSION to
accept the changed information in Shirley Ransome’s record.

You can modify any record from the list, or enter a new
record, as long as the Enter in List command is in effect.

When you have finished making the changes you want,
choose Enter in List again.

4th DIMENSION turns off the “Enter in List” mode.
You can now only view the list of records; you can’t
modify them.
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The Next Step

In this chapter you have seen how quickly you can enter and
modify records in a 4th DIMENSION database, using either the
input layout or the output layout. You have imported records
from a text file. You have also seen how to move from record
to record with either layout.

The next chapters show you how you can search for single
records or groups of records, sort records into various
sequences for different purposes, graph the information,
and print lists and quick reports.

[T vou want to take a break at this time, go ahead and quit
~th DIMENSION. You can open this database again when
vou start working on the next chapter.
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QUICK START

SELECTING, SEARCHING, AND
SORTING

Estimated time to complete: 12 minutes

Now that your records exist, you can manipulate them in
useful ways. Three of these ways involve the basic database
operations selecting, searching, and sorting.

You select a record in order to work with it. You have already
selected a record and modified it. 4th DIMENSION allows you
to select a group of records, so that you can work on all of
them.

Searching allows you to find a specific record or a group of
records among all the records in a file. You may want to view
the information on a particular record. You may need to
update the information on several records. Or you may want to
isolate a group of records to perform a calculation on them or
to print them.

You can sort the records into different sequences, depending
on your current needs. If you need to print an employee list,
for example, you’ll probably want the records to be in
alphabetical order by last name and first name, as in the
telephone book. However, if you want to compare salaries
within job classifications, you’ll probably want the records
arranged by job title.

In this chapter you will learn to
m select groups of records
m search for a specific record

m sort the records
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Selecting Records

The simplest method of looking for a record is browsing:
scrolling through the records, looking for the ones you want.

4th DIMENSION allows you to select a group of records by
clicking. Then you can isolate the records you have selected.
The records you select do not have to be in any particular
sequence; 4th DIMENSION allows you to create a group based
on selecting any records.

1. Select the first record.

Now in order to select additional records, you will hold down
the command key as you click them.

The command key has the 3 symbol on it.

2. Use Command-click to select three or four additional records
anywhere in the list.

4th DIMENSION highlights the records you click.

[ ® File Edit Use Enter Select Report Special
LE'_ Employees: 56 of 56

15|
i

First Name Last Name Start Date Salary Title
Alice Bentley 3/6/87 21000 [Engineer
Biff Davis 1/2/80 43780 Salesperson
Shirley Ransome 1/11/80 26040 |Supervisor
Lance ‘Wolfram 1/14/80 27300 | Technician
Dennis Hanson 1/14/80 40520 [Manager
Andy Venable 1/15/80 43520 [Engineer
Bryan Pfaff 1/22/80 26440 [Secretary
Mancy Heizer 1/23/80 26270 |Clerk
Kathy Forbes 1/28/80 18840 |Secretary
Garth Hammons 2/6/80 50100 |Salesperson
Mary Smith 2/7/80 55000 |Engineer
Frederic Bell 2/14/80 60400 (Director
Alan Hull 2/20/80 41460 |Supervisor
Jan Perez 2/27/80 22560 |Technician
Figure 4-1

Records selected at random
3. Choose Show Subset from the Select menu.

4th DIMENSION isolates the records you have selected.
This group is called a selection.

Search Editor... €S
Search by Layout... %L
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L‘ File Edit Use Enter Select Report Special

i Employees: 4 of 56

First Name Last Name Start Date Salary Title

Tom Johnson 1/5/87 31000 |Engineer

Lydia Vernon 1/15/80 36870 |Supervisor

Jim Borrell 1/22/80 36540 |Salesperson

Shirley Malevanko 2/21/80 41050 |Designer

5 o)
Figure 4-2

A selection of records

The idea of a selection of records is a particularly important
concept in using 4th DIMENSION. For now, you need to know
only that whatever you do to the records applies only to the
records in the current selection. For example, if you were to
choose Print, only these few records would be printed.

To show all the records again, choose Show All from the
Select menu.

4th DIMENSION also allows you to select a range of records.
A range of records includes all the records in a sequence.

Click once near the top of the list to select one record.

Hold down the Shift key while you click a record farther
down the screen.

4th DIMENSION selects all the records between the two clicks.
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IFirst Name

Torn Johnson 1/5/87 31000 |Engineer
3/6/87 31000 |Engineer

Employees: 56 of 56
Last Name Start Date Salary

1/15/80 Engineer
1/22/80 Secretary
Borrell 1/22/80 36540 |Salesperson
Heizer 1/23/80 26270 |Clerk
Forbes 1/28/80 18840 |Secretary
Garth Hammons 2/6/80 50100 |Salesperson
Mary Smith 2/7/80 55000 |Engineer
‘Fr‘ederic Bell 2/14/80 60400 |Director
Alan Hull 2/20/80 41460 |Supervisor
Shirley Nalevanko 2/21/80 41050 |Designer
Jan Perez 2/27/80 22560 | Technician
] EE |

Figure 4-3
A range of records selected

If you wanted to make this group of records into a selection,
you could isolate them as you did the first group, by choosing
Show Subset.

7. You may want to practice selecting different groups of records
and making them into a selection.

Be sure to show all the records before going on to the next
section.

Searching for a Specific Record

4th DIMENSION provides automatic ways of searching. In this
section you will learn how to search for a specific record.

Suppose you want to locate the record for Mary Smith to
check her salary. To use the Search by Layout method, you
fill out a layout like the current input layout. 4th DIMENSION
can then match the record you want to see.

1. Choose Search by Layout from the Select menu.

Show All 86
Shaw Subset #H 4th DIMENSION displays the input layout. The control panel
search Editor... % has been replaced by Search and Cancel buttons.

Search by Layout...
Search and Modify...
Search by Formula...
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[ & file Edit #se fpter Select HBepart Spediat

[==———— search for Employees S==—"=———1=

&
Employees
Last Name |

First Name |

Start Date
Salary |

Title |

Qo

3] I

Figure 4-4
Search by Layout screen

2. Type smith in the Last Name field and mary in the First
Name field. Then click Search.

You don’t need to use an initial capital, because

4th DIMENSION ignores case when comparing values in an
Alpha field. 4th DIMENSION searches for all records with a
last name of Smith and a first name of Mary. Mary Smith’s
record appears on the screen.

[ & File Edit Use Enter Select Report Special

I=———— Fmployees: 1 0f 56 =02
IFirst Name Last Name Start Date Salary Title

Mary Smith 2/7/80 55000 [Engineer

Figure 4-5

A record isolated by a search

3. To view all the records again, choose Show All from the
Select menu. T )
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Show Al %6
$haw Subset S

Search Editor... %S
Search by Layout... L
Search and Modify...
Search by Formula...

Sort Selection...

Sort File...

Sorting the Records

4th DIMENSION can change the order in which records are
displayed based on the content of the fields. If you sort the
records based on the Last Name field, for example, the records
are arranged alphabetically by last name. In this case the Last
Name field is called the sort field, the field 4th DIMENSION
uses to sort the records.

If two or more of the employees have the same last name,
you will want to give 4th DIMENSION a second field to
determine the order of the records. This is the way the
telephone book is ordered. The records are ordered
alphabetically by last name, and within the same last name
the records are arranged alphabetically by first name.

4th DIMENSION can use up to 31 sort fields, so your records
can be arranged exactly as you require.

No matter how many different sort fields you use, each
one can be in either ascending order or descending order.
Ascending order is alphabetical order from A to Z.
Descending order goes from Z to A.

The information in the personnel database is currently
displayed in the order the records were entered (from earliest
to latest start date). Suppose you want to arrange the records
in alphabetical order by last name.

Choose Sort Selection from the Select menu.

4th DIMENSION displays the Sort dialog box, showing a list
of field names and a set of blank boxes. You will select field
names from the list to establish the sort order for the records.

Click Last Name.

4th DIMENSION enters Last Name in the first Sort field box.
This step instructs 4th DIMENSION to display the records in

alphabetical order, according to the entries in the Last Name
field.

Notice that both Last Name and First Name are displayed in
bold type in the list of fields. The bold type indicates that the
fields are indexed. When you use one indexed field to sort the
records, the process is almost instantaneous because

4th DIMENSION can order the records based on the index
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table; it doesn’t have to go through each record in sequence
to determine the order.

The arrow on the far right of the Sort field box points up,
indicating that the sort is in ascending order.

Ascending sort

order symbol Sort Employees...
b 21 |Last Name
[TCast Hame K>
. | |First Name N
Field names — Start Date
Salary
Title

Sort field boxes B

o=
[ii(iii ?zmmz%gx] [Rdd Formula] [Se%e‘:e) [ CancelJ ( Sort ]
Figure 4-6
The Sort dialog box
3. Click Sort.
4th DIMENSION sorts the records and displays them in the
new order.

Now suppose you want to see Mary Smith’s record grouped
with others containing the same job title so that you can
compare her salary to theirs.

4. Choose Sort Selection from the Select menu.

5. Click Title to enter this field in the first Sort field box.

6. Click Salary to enter this field in the second Sort field box.
7. Click the arrow to the right of Salary in the Sort field box.

ll‘l The arrow changes to point down to indicate that the sort is
in descending order.

This means that the records will be sorted in ascending
alphabetical order by Title (from A to Z), and within Title
in descending order by Salary (from highest to lowest).
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This time, when you sort, 4th DIMENSION sorts sequentially,
going through the records building up the new order.

Even though the sequential sort takes a short time, it takes
noticeably longer than the indexed sort you performed before.

Click Sort.

4th DIMENSION sorts the records and displays them by title.
Use the scroll bar to move to the engineers’ records.

[ & File Edit Use Enter Select Report Special

i Employees: 56 of 56

First Name Last Mame Start Date Salary Title
Nancy Heizer 1/23/80 26270 |Clerk
Bil Guillardo 3/6/80 19610|Clerk
John Johnson 3/19/80 18250 |Clerk
Rick Reed 4/15/80 18150 [Clerk
Don Terry 5/5/20 16190 |Clerk
Barbara Doyen 6/11/80 42210 |Designer
Shirley Nalevanko 2/21/80 41050 |Designer
Susan Grambo 7/1/80 36300 |Designer
Chris Nash 4/28/80 34980 |Designer
Mike Krause 3/18/80 333240 |Designer
Frederic Bell 2/14/80 60400 |Director
Mike Ross 4/17/80 58910 |Director
Mary Smith 2/7/80 55000 |Engineer
Dick Lockert 6/25/80 51772 |Engineer
Andy Yenable 1/15/80 43520 |Engineer
Mary Secull 7/16/80 42610 |Engineer
Bill Horton 7711480 41895 |[Engineer
Bill Johnson 7/22/80 28620 |Engineer
<]

Figure 4-7

Records sorted by title and salary

The records for each job title are grouped together. You can
now see that Mary Smith’s salary is significantly higher than
the salaries of others with the same job.

The Next Step

Selecting, searching, and sorting are basic database operations
that you can do easily with 4th DIMENSION. Chapter 11 in
the 4th DIMENSION Tutorials shows you how to use more
complex search conditions.

Another basic database operation is printing reports of the
records. In the next chapter you will see how printing works
in 4th DIMENSION.
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File
New Database...
Open Database...

Import Data...
Export Data...

Choose File/Layout... %F

Page Setup...

Quit % |

QUICK START

REPORTS

Estimated time to complete: 15 minutes

There are many ways to print the information from a

4th DIMENSION database. You can print the records one

at a time by using the input layout. You can print them as a
list by using the output layout. You can create a report that
prints a selection of records and provides totals and subtotals
for numeric fields. The report you print can include graphs,
pictures, and other graphic elements such as diagrams,
borders, and different type fonts and styles.

In this chapter you will look at two methods for printing
information in your database. You will learn how to

® print all the records using an output layout

® use the Quick Report editor to print a few fields from
all the records

m create a report that calculates a total

Using a Layout to Print Records

In this section you will learn about printing records using an
output layout.

Suppose you have decided to print all your employee records
so that you will have a printed copy of all the information. In
this section you will use your output layout for printing.

Start in the User environment, displaying all the records.
Sort the records by Last Name and First Name.

If you don’t know how to sort the records, return to Chapter 4
to review the steps.

Choose Print from the File menu.

4th DIMENSION displays the Choose Print Layout dialog box.
This dialog box allows you to choose any layout for printing.
The current output layout, Employee List, is already selected,
so you don’t need to select a different one.

Click OK.
4th DIMENSION displays a Page Setup dialog box.
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Click OK.

4th DIMENSION displays the Print dialog box. If you have
a printer connected to your computer, you can print these
records. However, since these are practice records, you
probably want to preview the report on screen instead.

Click the “Preview on screen” check box, and then click OK.

4th DIMENSION displays on the screen what a printout would

look like.

[ % BIIW Fdit Use Enter Select Report Special
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Stop Printing

Figure 5-1
Previewing the printout of records

Click the Zoom button to see the report close up.

The closeup shows the list of records as it would appear if
it were printed.

When you’ve finished, click anywhere on screen, and then
click Stop Printing.

4th DIMENSION returns to the output display.

With this quick example, you can see that you can use any
of your layouts for printing the information. If you wanted
the records printed in the single-record format, you could
print using your input layout.
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Using the Quick Report Editor

4th DIMENSION provides the Quick Report editor so that
you can design and print reports quickly. Suppose you want a
list of employees that includes only their names and job titles.
This report will be a list similar to the one you just printed,
except that you will omit some fields. You can quickly design

this report.
Report 1. Choose Quick from the Report menu.
Quick...
4th DIMENSION displays the Quick Report editor.
Graph...

€ File Edit Font Style Other

[X] Report with frame

Field list
Salary
Title
Work area
Sort field list e
Ruler 100 200
<
| Osum [ #varage [ s
O Mas O Count

Cancel ] [ 0K ] O &uste soivmn widih

Figure 5-2
The Quick Report editor

In the next steps you will drag the fields you want to use
from the field list into the work area. As you will see,
4th DIMENSION automatically creates columns for the
information to be printed.

2. Drag the Last Name field from the field list into the work area.
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Reports... [ Report with frame

First Name
Start Date
Salary
Title

Sort
<<Add Sort>>

oo 200

=l

|| Osum O#werage [Jndin
[ sas [ Count
Cancel J [ 0K ] O &t solumyn widih

Figure 5-3
Dragging a field to create a column

When you release the mouse button, 4th DIMENSION creates
a column for employee last names. It also adds rows for the
header (H), detail (D), and totals (T). The Header row contains
the field label that will be printed at the top of each column.
The Detail row contains what will be printed once for each
record. The Totals row will later contain a formula to calculate
a value from all the records.

Drag the First Name field from the field list into the work
area, to the right of the first column.

4th DIMENSION creates a second column, for employee
first names.

Drag the Title field from the field list into the work area,
to the right of the second column.

4th DIMENSION creates a new column for the Title field.



Column headers

QUICK START

[ Report with frame

|
Last Name iFirst Name RUWE

Last Name iFirst Name SRME

Sort
<<Add Sortr>

| [ Sum [J Average [ Min
[0 M™Max [] Count
Cancel | [ 0K | [XAuto column width

Figure 5-4

4th DIMENSION creates a column for each field

You can replace a field by dragging the new field into the
column you want it to occupy. You can insert and delete
columns with menu commands.

You now need to establish the sort order to determine the
order in which the records will be printed. You are going
to use two Sort fields, Last Name and First Name.

Drag the <<Add Sort>> phrase from the Sort field list to
the Last Name column in the work area.
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e I

New ¥N
Open... %0

Save... ®S
Save as...

Print to...

Reports. ] Report with frame

- o First Name iTitle
et i First Name iTitle
First Name B

Start Date
Salary
Title

[ Sum [J Average O Min
O ™Max [ Count
( cancel ] [ 0K | X Auto column width

&
]

Figure 5-5
Dragging the <<Add Sort>> phrase to create a Sort field

When you release the mouse button, 4th DIMENSION adds
Last Name to the Sort field list. This step establishes the sort
order for the report.

If you make a mistake, you can remove a Sort field from
the list by choosing Delete Last Sort from the Other menu.

Drag the <<Add Sort>> phrase from the Sort list onto the
First Name column in the work area.

When you release the mouse button, 4th DIMENSION adds
First Name to the Sort list. You have created a two-level sort.
The primary sort field is Last Name, and the second sort field
is First name. For employees with the same last name, the
records will be sorted by first names.

You are now ready to print your employee list.
Choose Print from the File menu.

Check to make sure that “Preview on screen” is selected
(unless you want to print the report on your printer), and
then click OK.

4th DIMENSION prints the report.

Click the Zoom button to examine the report closely.
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Last Name iFirst Name iTitle

Alden Rick Supervisor
Ames Cliff Technician
Baldwin Steve Supervisor
Bell Frederic Director
Bentley Alice Engineer
Borrell i Salesperzon
Brothers Walter Technician
Conrad Harry Salesperson
Cote Laurent Technizian
Davis Biff Salesperson
Doyen Barbara Designer
Eubanks Jeff Secretary
Evans Maggie Salesperson
Evslin John Secretary
Forbes Kathy Secretary
Forras John Secretary

Figure 5-6
The report previewed on screen

You have created and printed a useful report in just a few
minutes.

To prepare for the next section, you will now return to the
Quick Report editor.

Click anywhere on the screen to return to the full-page view,
and then click Stop Printing.

4th DIMENSION returns to the Quick Report editor.

If you wanted to print such a report each month or each
quarter, you could save this report and use it again. When
the time came to print, you would simply load the report
design and print it again. The printed output would reflect
any changes you had made to the database in the meantime.

Since this is a practice session, you do not need to save this
design. You will modify it in the next section.
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Calculating a Total on a Report

4th DIMENSION’s Quick Report editor can calculate summary
statistics, such as sum, average, maximum, minimum, and
count. Suppose you want to have 4th DIMENSION calculate

a total for salaries. Your first step is to add a Salary column

to the report design that will print the salary figures for each
record.

1. Drag the Salary field from the field list into the work area,
to the right of the Title column.

4th DIMENSION creates a column for salaries.

2. In the Salary column, select the cell intersected by the
Total row.

X Sum 3. Click the Sum check box below the work area.

4th DIMENSION adds a Sum symbol to the selected cell,
instructing 4th DIMENSION to calculate the total of all the
salaries when the report is printed. The total salaries for

all the records in the current selection will be printed in the
Salary column.

To describe the calculated total, you can now add some
descriptive text. The text will be printed only once, when
the total is calculated.

4. Select the cell just to the left of the calculated cell you just
created, then click again to create an insertion point.

5. Type Total Salaries:



Salary column

Total row

QUICK START

% File Edit Font Style Other

Reports... ] Report with frame

- Last Narne iFirst Name iTitle Sa]a‘rg

Last Narne Last Name iFirst Name iTitle Salary

First Name

Start Date

Salasn Total Salaries: Sumn
]

Additional text

Click the Sum
check box

Title

Last Name
<Add Sortrr

E] Sum [JAverage [ Min

£ [JMax ] Count
[ Cancel ] [ 0K ] ] Auto column width

Figure 5-7
Instructing 4th DIMENSION to calculate a total

Now print this new report.

4th DIMENSION prints the salary for each employee,
then calculates the total salaries at the end of the report.

Click the Next Page button to display another page.
Click the Zoom button to see a close-up view of the page.
The total salaries figure appears on the last page.

Figure 5-8 shows a close-up view of the report as previewed
on screen.
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10.

« WAICM Edit Font Style Other

Last Name

First Name

Title

Salary

Preston
Ransome
Reed
Ross
Scull
Sleeter
Smith
Stephens
Terry
Tompkins
Yenable
Yernon
Yoltz
Wolfram

Stephen
Shirley
Rick
Mike
Mary
Michael
Mary
Keith
Don
Andy
Andy
Lydia
Scott
Lance

Manager
Supervisor
Clerk
Director

:Engineer

Technician
Engineer
Salesperson
Clerk
Technician
Engineer
Supervisor
Technician
Technician
Total Salaries:

39930
36040
18150
58310
42610
25650
55000
44790
16190
19770
43520
26870
25150
27300
2039952

Figure 5-8

The report previewed on screen

Return to the Quick Report editor by clicking anywhere on the
screen, then clicking the Stop Printing button.

Return to the output display by clicking either OK or Cancel

in the Quick Report editor.

The Next Step

Printing reports is a basic way of communicating information
in your records.

In the next chapter you will see how you can produce labels
and graphs from the same records.
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LABELS AND GRAPHS

Estimated time to complete: 10 minutes

The records in your database can be used for many purposes.
You have seen how to print reports and calculate totals.

4th DIMENSION provides two more ways to print the
information from the records. In this chapter you will learn
how to

m create labels with the Label editor

m create a graph of the information

Using the Label Editor

4th DIMENSION’s Label editor allows you to create labels
of any size, so you can match the labels you are using on your
printer.

For example, if you are using label forms that print three
labels across a sheet, you can design the labels to fit this
format. Or if you are using label forms that print one label
at a time on a narrow strip, you can design the labels to fit
that format.

You can print many types of labels. Suppose you want to print
a label for each employee’s file folder that includes only the
employee’s name and start date. The 4th DIMENSION Label
editor will create a clear and consistent file folder label for
each employee. File folders so labeled make it easy to keep
track of the paperwork for each employee.

You can follow the steps in this tutorial even if you don’t have
label forms in your printer. As in the preceding tutorial, you
can preview the labels on the screen instead of printing them
if you choose.

You start in the User environment.

Report 1. Choose Labels from the Report menu.

Labels...

e 4th DIMENSION displays a Page Setup dialog box.
_rap

The Label editor needs to know the orientation and paper
type you are using in your printer. For purposes of this
procedure, assume you are using a vertical orientation with
standard paper.
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Field list

Click OK.
4th DIMENSION displays the Label editor.

You need to do only three things to design your labels:
set the number of labels on your page, choose the fields
you want to print from, and, if necessary, set the margins.
This tutorial assumes that your mailing label forms are
spaced 3 across and 11 down on each page.

First Name New Line

Shows one
sample label

Start Date

eary Add to Line
Titl
e Clear Last

Shows the labels
on each page

@ O Use

Layout |

Labels across: d[JLUn:

Top margin: 0

Bottom margin: |0

Left margin: 0

Right margin: 0
@ Pisels O Cm O Inches

Cancel

Figure 6-1
The Label editor

The Label editor starts with a 3 in the “Labels across” box,
so you need to change only the down box.

Enter 11 in the “Labels down” box.

4th DIMENSION changes the full-page display to reflect the
new values. The sample label changes to reflect the new size.
The display lets you see exactly how labels will be printed on
each page.

Select First Name in the field list.

You want a standard label with each employee’s first and
last name on the first line. Selecting the First Name field is
the first step toward placing it on the sample label.

Click the New Line button to the right of the fields list.

4th DIMENSION creates a line on the sample label and places
the First Name field in it.

Select Last Name in the field list.
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(Add to Line 7. This time click the Add to Line button.
4th DIMENSION adds Last Name to the first line, next
to the First Name field.
The New Line and Add to Line buttons are the primary
buttons you use to design any label. The New Line button
creates a line and places the selected field on it. The Add
to Line button adds the selected field to the last line created.
8. Select the Start Date field, and then click New Line.
4th DIMENSION creates a second line and places the
Start Date field on it.
Creates line and
places field on it e ——— 2 —{ New Tine )
Place field on e |_(Add to Line)
same line Title
i DL::out .
Labels across: @down:@ i{——ﬁ) L"OL"“'__J
Top margin: D [ L j |~ (:I\L’ c? 63 Cnr of
Bottom margin: |0 M‘/ “’P ./ } -7
) zinCineg I S
Left margin: 0 m ) \:7
Right margin: |0 (Ccancel | My € ku’&“(@/&lg .
@ Pigels O Cm O Inches & . -
De s ?effﬂe'u‘cg
Figure 6-2 ﬁS’c,wcu —1),"7//1\_7 ‘
Effects of using the New Line and Add to Line buttons ’?45“* /¢ 7
You can now print your labels. You can also save this label
design to use later. You won’t have to create it again; simply
load it and then print.
9. To print your labels, click Print.
4th DIMENSION displays a Print dialog box.
10. If you don’t want to print the labels, be sure “Preview on
screen” is selected before clicking OK.
11. After you have printed your labels, click Stop Printing to

return to the output layout.

CHAPTER 6: LABELS AND GRAPHS 65



Graphing Information

So far you have concentrated on manipulating individual
records. Your lists and labels essentially reproduced the
information in your database in a different form. Only when
you calculated a total for salaries did you begin to make use
of 4th DIMENSION’s ability to summarize the information
in the records.

Now you will see how to quickly graph the information

in your database to obtain a visual summary of the data.
For example, suppose you decide to graph the total salaries
for each job classification. This graph will give you a good
picture of how your company allocates its resources.

1. Choose Graph from the Report menu.
4th DIMENSION displays the Graph dialog box.

(TTIET I

Pictures

Employees K-Axis Y- Axis
Last Name K> (None)
First Name | (MNone)
Start Date (None)
Salary (None)
Title (None)

[ Cancel ] rﬁraph ]

Il

Figure 6-3

Graph dialog box

Field names are listed on the lower left of the screen.

You will first select the field you want to serve as the x-axis
value from the list. The x-axis value is the value that will
be graphed along the horizontal coordinate. You want to
see the job titles along the x-axis.

2. Click the Title field name.

4th DIMENSION enters Title as the x-axis value and highlights
the first y-axis value. A y-axis value is avalue that will be
graphed along the vertical coordinate. You want to see salaries
graphed vertically.
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The Salary field name is the only option; the other field

names are grayed out. Since Salary is the only field that
contains numerical values, it is the only field that can be
graphed on the y-axis.

3. (Click the Salary field name, and then click Graph.

4th DIMENSION creates a bar graph showing the total salaries
paid for each job title.

£00000
550000 -
S00000
450000

W Salary

Supervi Technic Directo Enginee Salespe Designe Secreta Clerk Manage

Figure 6-4

A bar graph

As you can see in the figure, of all the job titles, Salesperson
uses the most salary money. You decide to display the graph
in a different way, to get a better grasp of the relative salary

expenditures for each job title.

4. Choose Pie from the Graph Type menu.
hlp. Cotumn 4th DIMENSION displays a percentage of the total salaries
m Proportional Column for each _]Ob title.
1!!1 Stacked Column 604% 137%

.~ Line

M Area
va Scatter

12_?_1 Picture

B Supervisor
Technician
£ Director

B Engineer

I Salesperson
M Designer

[0 Secretary
B3 Clerk

B Manager

I
|

Figure 6-5
A pie chart

5. Click OK to return to the output layout.
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The Next Step

Congratulations. You have created a completely functional

database, and you have practiced several of the most
important tasks involved in keeping track of information
and analyzing it.

You have used the basic features of the Design and User
environments. You have

m created a single-file database

m created two layouts

m entered and modified records

m selected, searched, and sorted the records
m printed reports from the information

m created file folder labels

m summarized the information in graphs

If you want to learn about additional features of
4th DIMENSION, turn to the other books provided
with the application.

For more step-by-step introductions to 4th DIMENSION
features, work through the 4th DIMENSION Tutorials.

4th DIMENSION Design Reference provides complete
information about all parts of the Design environment.

4th DIMENSION User Reference provides complete
information about all parts of the User environment.

4th DIMENSION Language Reference provides complete
information about the language you can use to control
4th DIMENSION databases.
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Add to Line button, in Label
editor 65

alphabetical sort order 4648

Alpha field type 9, 10
searching for 45
symbol for 11

alphanumeric information 9

Append button, for importing
records 32-33

application icon, double-clicking
on ix

applications, importing records
from 30-33

arithmetic operations. See
calculations

ascending sort order 46, 47

ASCII code, in Import Data
dialog box 31

attributes. See field attributes

automatic saving 11, 21

automatic searching 44-45

B
bar graph, creating 67
bold type
as field attribute indicator 11
in tutorial format iv
browsing 42
buttons, on control panel 26

C

calculations
with dates 10
with Quick Report editor
58-60

Cancel button
in data entry 29
on Search by Layout screen
45, 44

carriage return, ASCII code
for 31

characters, selecting 34

Choose Graph command (Report
menu) 66
Choose Labels command (Report
menu) 63
Choose Print Layout
dialog box 51
clicking, defined ix
close box, for closing layout
windows 21
columns, creating for
reports 53-55
command-click, for selecting
records 42
command key 42
commands, current selection
and 43
comments, in tutorials iv
control panel
on data entry screen 26
for modifying records 34-36
create operations
database 3-21
fields 8-11
labels 63-65
layouts 15-21

D
databases
advantages of vi
components of vi, vii, 3
creating 3-21
layouts of vii
naming 5
opening 11
sample x
types of v, viii
data entry
common layout for 18
from text file 30-33
data entry screen 26
data management,
User environment for 25
date entry format 27
Date field type 9, 10
entering data in 27
symbol for 11

QUICK START

decimal points, Real field
type for 10
default file or field names 8
Delete Last Sort command
(Other menu) 56
descending sort order 46
Design environment 5
User environment vs. 25, 26
Design menu, Layout command
16, 19
design of report, saving 57
desktop, defined ix
detail row, in Quick Report
editor 54
dialog boxes x
dollar amounts
entering 27
Real field type for 10
double-clicking
defined ix
for output layout 20
dragging, method of x

E
End of field/End of record codes,
in Import Data dialog box 31
entering data. See data entry
entering records 26-29
Enter key, for entering records 28
Enter menu
Enter in List command 36
Modify Record command 34
New Record command 26
environments
Design 5, 25, 26
User 25, 26, 51, 63
error correction
in Append list 33
in Quick Report editor 56
removing extra field 10

F
field attributes 8, 9, 10

Field Attributes dialog box 6-7
Field dialog box 8
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field labels vii
in input layout 18
in output layout 21

fields vi. See also field attributes;
field types
creating 8-11
display format of vii-viii
moving between 27, 34
selecting characters in 34
selecting for printing 53-55
sort 46
symbols for 11

field types 8-9, 11. See also
specific field types

File menu
Import Data command 31
Print command 51, 56

filenames 5
changing 6-7

files vi

font size
in input layout 17
in output layout 19

4th DIMENSION
installing x
opening 4
quitting 11

4th DIMENSION Design
Reference 9, 15, 68

4th DIMENSION Language 68

4th DIMENSION Tutorials 15, 68
for changing number display
format 27
for complex search
conditions 48

4th DIMENSION User
Reference 68

G
Graph dialog box 66
graphs
printing 66-68
types of 67

H

hard disk, copying sample
databases to x

header row, in Quick Report
editor 54

icons, defined ix
Import Data command (File
menu) 31
Import Data dialog box 31, 32
importing records 30-33
User environment for 25
Indexed field attribute 9
bold type display for 11
Indexed field type, sorting on
4647
input layout 15
creating 16-19
modifying records in 34-36
for printing records 52
searching by 44-45
Insert button, for importing
records 33
installing 4th DIMENSION x

L
Label editor 63-65
labels
previewing on screen 65
printing 63-65
Layout command
(Design menu) 16, 19
Layout dialog box 16, 19
Layout editor 18
layouts vii-viii, 15. See also input
layout; output layout
creating 15-21
modifying 18
layout templates 17, 19
Layout window
closing 21
expanding 18
list
creating output layout
for 19-21
modifying records in 36

M

Macintosh computer, basic
operations for ix-x

mailing labels 63-65

mathematical operations. See
calculations

menu commands, choosing x

modifying records 34-36

Modify Record command
(Enter menu) 34

mouse
for moving between
fields 27, 34
use of ix

N

naming a database 5

New Field command (Structure
menu) 8

New Layout dialog box 16-17,
19, 20

New Line button, in Label editor
65

New Record command (Enter
menu) 26

numbers
display format for 27
field type for 10

O

Open button, for importing
records 31, 33

Other menu, Delete Last Sort
command 56

output layout 15
creating 19-21
modifying records in 36
for printing records 51-52

P

Page Setup dialog box 51, 63

password access, in File
Attributes dialog box 7

pie chart, creating 67

pointer, defined ix



Preview on screen 52
with calculated totals 59-60
for report 5657
for labels 65
Print button, in Label editor 65
Print command
(File menu) 51, 56
current selection and 43
Print dialog box 52, 65
printing 51-67
with calculated totals 58-60
graphs 6668
with input layout 52
labels 63-65
with output layout 51-52
Quick Report editor for
53-57
sorting for 41
User environment for 25

Q

Quick Report editor 53-57
for calculating 58-60

quitting 4th DIMENSION 11

R

range of records, selecting 43

Real field type 9, 10
symbol for 11

records  vi
display of vii-viii, 29, 34
entering 26-29
importing from another
application 30-33
modifying 34-36
moving between 34-36
output layout for listing
19-21
printing 51-52
searching for 44-45
selecting 34
selecting groups of 42—44
sorting 4648

Remove button 33

renaming a file 67

Report menu
Choose Graph command 66
Choose Labels 63
reports 51-60
calculating totals on 58-60
previewing on screen 52,
56-57, 59-60
Quick Report editor 53-57
saving design for 57
sorting for 41
sort order for 55-56
User environment for 25
size box 21
rows and columns
in output layout 19-21
in reports 53-55

S
saving
automatic 11, 21
label design 65
report design 57
screen display. See also layouts
for dates 27
for dollar amounts 27
field attribute indicator 11
field type symbols 11
previewing labels on 65
previewing reports on 52,
56-57, 59-60
scroll bar, for viewing records 33
Search button 45, 44
searching 4445
case in 45
Indexed field attribute for 9
purpose of 41
for a specific record 4445
User environment for 25
Search by Layout command
(Select menu) 44
selecting records 34
in groups 42-44
purpose of 41
in range 4344
selection, defined ix, 42

QUICK START

Select menu
Search by Layout
command 44
Show All command 34,
43,45
Show Subset
command 42, 44
Sort Selection command 46,
47

Shift-Tab, for moving between
fields 27

shortcuts
double-clicking ix
for output layout 20

Show All command (Select
menu) 34, 43, 45

Show Subset command (Select
menu) 42, 44

Sort dialog box 46

Sort fields 46
for report 55-56

sorting 4648
Indexed field attribute for 9
User environment for 25

sort order, for report 55-56

Sort Selection command (Select
menu) 46, 47

spreadsheet, importing records
from 30-33

statistics, for reports 58—60

Stop Printing, report preview 52,
57

Structure menu, New Field
command 8

Structure window 6-7

T
Tab, ASCII code for 31
Tab key
for moving between fields
34,27
for moving between
records 36

templates, layout 17, 19
text file, importing records from
30-33
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totals, for reports 58—60

totals row, in Quick Report
editor 54

tutorials, format used in iv

types. See field types; specific

field types

U

Use menu, User command 26
User environment 25, 26
for creating labels 63
printing in 51

w

Welcome screen 4
windows, expanding size of. See
size box; zoom box

v

zoom box 18
for expanding Layout
window 18
size box vs. 21

Zoom button, for checking report
52, 56





